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1.

ikl

GD32 MCU#ZH£IEC60730 ClassBililEE S #f, X T R4 £411GD32 MCU, #i& 2t F &

FIH TRERAR, P AEXT ] — R A E RS (85 B 47 IEC60730 H RS A IERT, Wl @il F8 A A%

R T RIE R B An & o AN H 2 il 5 7 4 A 44 GD32F4xx % 41 it v 1£ A [A] IDE
(Keil/lAR/eclipse) T, P REEED, # P& P #EIEC60730 ClassBiliilFE.
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2.

2.1.

IEC60730 ClassB \if EE#

GD32 MCU#LIAR. Keil. eclipse?f 1 FIIEC60730 ClassBililF S #, =MIT KA R
PR TRERIRABAFAE ZE 5o T DB N =R FF A A8 T U A

AR FH2E 05 T -GD32F470IKEAT TR T .

IAR 3R NIEE TEBE

1. MRS s T 2 2 gd32faxx_test.h 3 AF g% IAR_SYSTEMS_ICC__ FHJRAM
WA, WER-1. £2qd32f4xx_test.h FRAMIZIRHR .

2-1. & gd32f4xx_test.h H RAM 45

[CJ#ifdef._ IAR SYSTEMS ICC

__ ICFEDIT region ROM start_ ;

__ICFEDIT region ROM end !

__ ICFEDIT region RAM start_ ;

__ICFEDIT region RAM end ;

__ ICFEDIT region IECTEST PARAM start_ :
xte __ICFEDIT region IECTEST PARAM end  ;

ST_PARAM START - - - (
ST_PARBM END ((uint32

1.__iar program start(void);

1.-Reset_Handler(void) !
DefaultSystemStartUp() -Reset Eandler ()

void -test_fail reset(void):

| #endif ./*._ IAR_SYSTEMS ICC__

2. f# TRE H xR Starup SO NS BN, —EMFELHDE R, WER-2. FFIX
AR AR, [FIEINClassBZE A2 T

2-2. B

Files £+ B
2 @ Project - Debug o
M Application )
B CMSIS ]
M Doc
B GD32Fdo EwalL [ ]
B GD32F 4x00_Petipherals (]
B [ECE0730_ClassB [ ]
=1 W Starup

R startup_gd3efds0_470s | .
B Output
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. T GD32F4xx ZFIf4 IEC60730 ClassB Efstaics
/& 2-3. %I ClassB FE (3] IAR T2
Files o .
= @ Project - Debug v
M Application e
B CMBIS .
M Doc

- Bl GO32F dee EWAL

- Wl GD32Fdxx_Peripherals

o W ECRO730_ClasshE
go32ido_test_clock.c

[a] g 32fdex_test_cpu_prerun_lAR s
[a] gd32fde_test_cpu_run_lAR.s
go32fdo_test_flash.c

B gdd32fho_test_fullram_run_lAR.s
[ god32fde_test_fulllcmram_run_|AR s
god32fdo_test_param.c
go32fdoc_test_prerun.c
gd32fdx_test_program_counter.c
go32fde_test_ram.c

qod 32{do_test_run.c

] Starup

B Output

[H [
| N

EEEEE BB e 8 e

HRACAFEHAMSR RS, WERBSR: &R S, W T ZAE 4 E Sk
GD32F4xx_Firmware_Library\CMSIS\GD\GD32F4xx\Source\ARM T, E #7145 & 4 Hi s
F RS fA B,

BR-4. RSB FTREATEE, M F A ST B AR
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& 2-4. B%.s B3I

| _vector_table

MODULE 2cstartup

; Forwvard declaration of sections.
SECTION CSTACK:DATA:NOROOT (3)

SECTION .intvec:CODE:NOROOT (2)

EXTERN test_prerun

EXTERN
EXTERN
PUBLIC

__iar_program start
SystemInit
__vector_table

DATA
top of stack

DCD sfe (CSTACK ;
o : s oot

Reset Handler --> test prerun

DCD NMI_Handler ; Vector Number 2,NMI Handler
DCD HardFault_Handler ; Vector Number 3,Hard Fault Handler
DCD MemManage_Handler ; Vector Number 4,MPU Fault Handler
DCD BusFault_Handler ; Vector Number 5,Bus Fault Handler
DCD UsageFault_Handler ; Vector Number 6,Usage Fault Handler
DCD 0 ; Reserved
DCD 0 ; Reserved
DCD 0 ; Reserved
DCD 0 ; Reserved
DCD SVC_Handler ; Vector Number 11,SVCall Handler
DCD DebugMon_Handler ; Vector Number 12,Debug Monitor Handler
DCD 0 ; Reserved
DCD PendSV_Handler s Vector Number 14,PendSV Handler
DCD SysTick_Handler ; Vector Number 15,SysTick Handler
3 . B ®w T B m &£ X f#H Xk C # K f#Hl p

N: .\GD32F4xx_IEC_Test\GD324701_EVAL_Demo_Suites\Projects\IEC_TestEWARM) T
[FIEC_TEST_BOOT_FLASH.icf XX, 1 A&R-5. B2 H gt AT~ NS5y, HR4E
5 F B FIHE 2 Flash FIRAMIF) K /INE Bt 24 56 Fr o

& 2-5. B BN

1 SYE##ICF### Section handled by ICEF editor, don't touch! %%/

2 f*-Editor annotation file-*/f

3 /% IcfEditorFile="5TO0LKIT DIRfhconfighide\IcfEditor\cortex vl_O.xml™ */
4 f¥-Specials-¥%/

5 define symbol _ TCFEDIT intwec start = 0x08000000;

6 S¥-Symbols-*/

7 define symbol _ ICFEDIT region ROM start = 0x03000000F
§ define symbol _ ICFEDIT region ROM end _ —[ox082FFFEE; |
9 define symbol _ ICFEDIT region REM start = 0x200000B0;
10 define symbol _ ICFEDIT region RAM end__ =[0x2002FFFE; |
11 define symbol  TCFEDIT region JECTEST EARAM start = O0x20000040;
12 define symbol ICFEDIT region JECTEST PREAM end = 0x200000B0;

4. &4 Options for node ‘Project’ ' TargetMIEL &, &£ 4a1& A S, W14&R2-6. Device &7
ER:
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GigaDevice

& 2-6. Device B B

Cateqarny:

Static Analysis

Runtime Chedking
C/C++ Compiler Library Options 2 MISRA-C:2004 MISRA-C:1998
Assembler
Output Canverter
Custom Build
Build Actions
Linker ) Care Cortex-M4
Debugger

Simulato
CI:SIB r @® Device GD GD32FR470=K B

CMSIS DAP
GDE Server () CMSIS-Pack
IHet/TTAG]et
J-Link/1-Trace
TI Stellaris
Mu-Link LittlE'
PE micro
ST-LIMK Big

ThirdParty Driver . 16
TI MSP-FET BE32

TI¥DS BER

Target Cutput Library Configuration Library Options 1

Processaor variant

Mone

Endian mode Floating point settings

FPU VFPvd single precision

TrustZone
DSP Extension

Secure
Advanced SIMD (NEQMN)

5. f£Options for node ‘Project’->C/C++ Complier->Preprocessor 73 i 24 fif T 5% 75 2 (1) T
B, FEBERTE LGS R T R %, 0 ER-T. BB ELT:
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GigaDevice
& 2-7. BTG EE

Categony: Factary Settings
General Options ] Multi-file Compilation
Static Analysis Dizeard Unused Publics
Runtime Checking
MISRA-C:1998 Encodings Extra Options
gisuirjflggnverter Language 1 Language 2 Code Optimizations Output
Custom Build List Preprocessar Diagnostics MISRA-C:2004
Build Actions
Linker [lgnore standard include directories
Debugger
Simulator Additional include directories: (one per ling)
2:12;5 DAP $PROJ DIRS\. .
DB Server $PROJ_DIREYNNAANGD32FRdo Firmware_Libran\GD32Fdue st
I4et/TTAGet £PROJ DIRELNNANGD32F4ex_Firmware_LibrandCMSISVGONG
I tink/1 Trace $PROJ_DIRS\.\.\.\.\GD32Fdix_Firmware_Librany\CMSIS
11 stellaris $PROJ_DIR$\ NN NGD32Fdiex Firmware Libran\CMSIS\GD o,
Nu-Link )
PE micro Preinclude
ST-LINK
ThirdFarty Driver
TIMSP-FET Defined symbals: (one per ling)
TIXDS
USE_STDPERIPH_DRIVER [IPreprocessor output to file
GD32F470 Preserve comments
GD32F470_BOOT FLASH Generate #line directives

6. #iiiOptions for node ‘Project’->Linker->config->Edit->Memory Regions, R 247t F 1)
¥ FHHMEROM (Flash) IRAMAL AHEL, 1 £2-8. B2 TFF 8 B H ISR ETT7 -

& 2-8. BRTEREVHLTE

Vector Table Memory Regions  Stack/Heap Sizes

Ctart: End:
ROM |EEENEE | |oxoszFrrFF |
RAM |0x20000080 | |0x2002FFFF |

7. {EOptions for node ‘Project’->Linker->Checksum ', 1&End address AFlash k7, 1 &
2-9. 2 T 72 /F £ 4 #jChecksum Z Efir 7k, 1 Extra Options & 5l + *H 73 il “ --keep

___checksum”,

10
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& 2-9. B TEEHEF K Checksum B E

#define Diagnostics Checksum Encodings

[1Fill unused code memaory

Config Lbrary Input Optimizations Advanced Output List

Extra Options

#define Diagnostics Checksum Encodings

[“llUse command line options:

Command line options: [one per

Fill pattern: OncFF

Start address: (B000000 End address: |OxB82FFFFF

Generate checksum
Checksum size: 4 bytes ~  Alignment: 4
Algorithm CRC polynomi: ~ | |0x=4C11DE7

Result in full size .
Initial value
Complement: As is w || | OxcFFFFFFFF
Bit order: M5B first ¥ [Use as input
[]Reverse byte order within word
Checksum unit size: 32-bit -
2-10. 7 Extra Options & KR IR E
Config Library Input Optimizations Advanced Output List

Extra Options

--keep _checksum

11
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2.2. Keil SR \EE TEBHE

1. MR G B0 B S i T & 2 gd32f4xx_test.h > RAMAIFlashil 7, 0 &R-11. £
260d32f4xx_test.h XHFRAMFF|ash 7

& 2-11. &% gd32faxx_test.h X4+ RAM A Flash 215

((uint32_t)512ul)

| {uint32_t) (( (uint32_t) FLASH END- (uint32_t)FLASH START) -/ FLASH BLOCK_SIZE)
12 - FLASH BLOCENUM WORDS - - - - (uint32_t) ( (FLASH_SIZE WORDS) -/ FLASH BLOCK SIZE)

#define -IEC_TEST_ PARAM START - - - - ((uint32_t *)0=x20000040)

#define -IEC_TEST_PARAM END- - - - - - ((uint32_t %) 0x200000B0)

#define -RAM START - - - - - - - - - (uint32_t-*)0x20000000

#define m_END ................. (Jinth_t SE N Ox2

#define TCMRAM START - - - - - - - (uint32_t - *) 0=l

#define TCMRAM END- - - - - - - oo (uint32_t - *)) 0=l

2. Fof TAE H % FStarupSCrEe FRI.sfashserh, REMFESure A, wnA&R-12. s/F3)
XHERBRTR, AR INClassBEE A4 2] TR A .

2-12. s FECMHRE
=% Project: Project
El-fa GD324700_IEC
{1 Application
{d CMsI5
{1 GD32F4xx_Peripherals
[ 1 GD32Fdoe_EVAL
{3 IECEe0730_ClassB

=R
startup_gd32f450_470.5

I d Doc
& cmsis

12
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& 2-13. %N ClassB FE 343 Keil T2

= Project: Project
E-fa GD324700_IEC

{1 Application

{d CMsIS

{1 GD32Fdxx_Peripherals

[ J GD32Fdx_EVAL

=@l I[ECE0730_ClassB
gd32fdxx_test_clock.c
gal32fdux_test_flash.c
gd32fdxx_test_prerun.c

gd32fdxx_test_param.c
gd32fdxx_test_ram.c
gel32fdux_test_run.c
gd32fdxx_test_cpu_prerun_KEILs
gel32fdux_test_cpu_run_KEIL.s
gd32fdxx_test_fullram_run_KEIL.s
gel32fdux_test_fullternrarn_run_KEIL.s
E-F Startup
] startup_gd32f450_470.5

£d Doc

& cmsis

B EEEEEEEEE

AR E M AT S A RS, W e W B S & W AR AR SRk
GD32F4xx_Firmware_Library\CMSIS\GD\GD32F4xx\Source\ARM T, 5 37 1% %3 F 24 7 ot
RS ISR B, I AR T AL bR BN B

Stack_Size EQU 0x00000400

AREA  STACK, NOINIT, READWRITE, ALIGN=3
Stack_Mem SPACE  Stack_Size

__initial_sp

; <h> Heap Configuration
<0> Heap Size (in Bytes) <Ox0-OxFFFFFFFF:8>

: </h>
Heap_Size EQU 0x00000400
AREA HEAP, NOINIT, READWRITE, ALIGN=3
__heap_base
Heap_Mem SPACE Heap_Size
__heap_limit

13
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IMPORT test_prerun

PRESERVES
THUMB

AREA RESET, DATA, READONLY
EXPORT _ Vectors

EXPORT _ Vectors End

EXPORT _ Vectors_Size

__ Vectors_End

EXPORT __ Check_Sum
ALIGN
_ Check_Sum DCD OxEEF15A05

_ Vectors_Size EQU _ Vectors_End - __ Vectors

AREA |.text|, CODE, READONLY

:I* reset Handler */
Reset Handler PROC

; /* reset Vector Mapped to at Address 0 */

__Vectors DCD __initial_sp ; Top of Stack
DCD test_prerun ; Reset Handler --> test_prerun
DCD NMI_Handler ; NMI Handler
DCD USBFS_IRQHandler : 83:USBFS

AREA CHECKSUM, DATA, READONLY, ALIGN=2

3. B EOINESCFIEC_TEST _BOOT _FLASH.sctH RS, 41~ R 40 byt N i EAs 1)
B4y CRE 4000 B 8dE T B s Flashil 7 15205 s B 3 U .o U 44 75D -

)

; ¥** Scatter-Loading Description File generated by uVision

*kk

14
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LR_IROM1 0x08000000 0x002FFFF8 {
ER_IROM1 0x08000000 O0x002FFFF8 {
*.0 (RESET, +First)
*(InRoot$$Sections)

ANY (+RO)

; RW data
RW_IRAM1 0x200000B0 0x002E000

{
ANY (+RW +2Z1)

; stack overflow test
STACK_IRAM2 0x2002E0BO UNINIT 0x00001F50
{
gd32f4xx_test_param.o (STACK_OV_TEST, .bss.STACK_OV_TEST)

startup_gd32f450_470.0 (STACK, +Last)

LR_IROM2 0x082FFFFC 0x0000004 {

ER_IROM2 0x082FFFFC 0x0000004

{
*.0 (CHECKSUM, +Last)

}

BN S ] #E“Options for Target -->Linker-->Scatter File”t &5 dEditi 4 Bl Al &0, &
2-14. JGHE G BONE I AFTTR:

15
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B 2-14. Zii BUnBX

Dw:i.l:l:l Tu’get] |:I1.|.l:'_u1.|.l:] Li.sl:ingl Uzer | C/C4+4 | Azn Linkaer ||]:|:-ug [ Ut:i.l:i.t:i.t:l
I™ Use Memory Layout from Target Dialog X/0 Base: |
™ Make RW Sections Pasition Independert R0 Base |muswoow

[~ Make RO Sections Postion Independent
™ Dont Search Standand Libraries
[+ Report ‘might fail' Conditions as Emars

R/W Base |MDDD{)DD'D

dizable Waminga: |

Scatter
tter [\JEC_TEST_BOOT_FLASHct J Ede.. I

Misc
controls
Linker |-cpu Cortex-M4fp "0 -
control  |~library_type=microlb -strict ~scatter " \EC_TEST_BOOT_FLASH sct"
sting w

0E | Caneel | Defaults | Help |

4. 1B “Options for Target"DEVICE WL E, EHF UGS, W &R-15. Device &

HroR:
& 2-15. Device BEC &
Device ITarget I Output I Listingl User I C/T++ I hsm I Linker I Debug I Ttilities
ISDﬂware Packs ;I
Vendor: GigaDevice Software Paclk
Device: GDIZFATOIK Pack: |GigaDevice GD32F4xx_DFP.3.0.2
Toalset: ARM URL: http://zd3Zmen. com/data/document=/ps:
Search: I
EEl GD32F4T0IK G032 iz a new 32-:bit high perfformance, low power consumption -
GDI2FATOVE universal microcontroller family powered by the ARM Cortex-M4 RISC
core which targeted at varous MCL application areas.
£ GDIZFATOVG G032 family integrates features to simplfy system design and provide
& customers wide range of comprehensive and superior cost effective
GD3ZRATIVI MCU portfolios with proven techniolagy and great innovation.
G032 family includes entry line, pefformance line and connectivity
GDI2FATOVE : 4
|lime: currerthy.
€3 GD32F470ZE
] GD22RAT0ZG GO32F470 - ARM Cortex-M4 Core
Frequency up to 240 MHz
€1 GD3ZFAT0ZI Flash access zero wait state
8 GD3IZFATOZE Single-cycle muttiplier and hardware divider
1 | - | v Memories W

5. fEOptions for Target->C/C++->Preprocessor Symbols s 24w TFE 7 R i %% 5
BETS A —8, W AR-16. B FHEZT N
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& 2-16. BTG FE

Optimization: |Level 000} -

[ Optimize for Time
[ Split Load and Store Multiple
[v¥ One ELF Section per Function

[ Enum Container always int

[ Plain Charis Signed

[ Read-Only Posttion Independent
[~ Bead-Write Position Independert

Device l Target l Output l Listing] Uzer CAC++ |ﬁ.5m ] Linker ] Debug ] Ttilities ]
Preprocessor Symbaols
Define: IGD32F4?D.VECT_TAB_FLASH
Undefine: |
Language / Code Generation
[ Execute-only Code [ Strict ANSIC Wamings: | Al Wamings -

-
[ Mo Auto Includes
[ C59 Mode

[ GMU extensions

Include
Paths

| A ANGD32Fde_Fimware _LibranCMSI1SYGDYWED32F e Include;

N NGD32F4xx_Fimware El

Misc |
Controls

Compiler
control
string

¢ —cpu Cortex-M4 fp -D__ MICROLIB g 00 —apcs=interwork —split_sections -| -
LA G032 & _Firmware_Librany CMS1S/G0/G032F 4o/ Include -|

6. i EAE A AL B 30 CRCIY, /& Z YN ngen_cre.bat>cff, BAkun &R2-17. JFEmi#t4t

BEXAE.
2-17. Bt

Command ltems
[=1-Before Compile C/C++ File
[ Run#1
[ Run#2
=--Before Build/Rebuild
[ Run#1
[~ Runz2
[=)--After Build/Rebuild

Device] Target] Dutput] Listing User leC++ ] fzm

] Linl:er] Debug ]

Uzer Command

Utilities |
Stop on Exi., S

[ Not Specified [
(2| Not Specified [

(23| Not Specified [
23| Not Specified [

[+ Run#1

gen_crc.bat

I,jj Mot Specified ||

[ Run#2

[ Bun “After-Build’ Conditionally
¥ Beep When Complete

[ Start Debugging

(2] Not Specified [

7. BJ5, fEUtilitiesik i £ ik CRC_LOAD.ini, Bk &R-18. JEAini E XL~ .

17
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2.3.

& 2-18. n.ini BB X

Device I Target ] Output I Listingl User ] C/C++ | Asm
Configure Flash Menu Command
(¥ Use Target Driver for Flash Programming

— Use Debug Driver —

[V Use Debug Driver

Init File: ’.\CRC_LOAD.iml

" Use Extemal Tool for Flash Programming

I L'Ln]terl Debug Utilities I

Settings | [V Update Target before Debugging

Command: I

=

Arguments: I
-

Configure Image File Processing (FCARM):
Output File: Add Output File to Group:

I I Application

Image Files Root Folder: ™ Generate Listing

eclipse AEINIEE TREBHE

R TREAE S AN IAET T IAS R RN, (HRRIPRMEL T R4 FsEA P, S8 RAM

1 Flash i1 7% BB FiAE, eclipse 3145 N L BT .

1. HRAE O HURE T HE gd32faxx_test.n S04 it GNU__ T FIRAMIZL T, fRIES i)
FlashfIRAM4: & 45 (6143 210, 0 £&R-19. #Hqd32f4xx_test.h FRAMIZIE 7 -

2-19. & gd32f4xx_test.h H RAM iz 5

lf—]#-'_f !defined- (_ RRMCC VERSION) -&&- (defined.(_ GNUC_ })
#define -FLASH_START ({uint32 t.*)0x08000000)
$define -FLASH SIZE SH END-(uint32 t)FLASH START)
#$define -FLASE | SIZE_WORDS £) FLASH END- (uint32 t)FLASH START)/4)
#define -FLASH END
#define FLASH BLOCK SIZE 1int32_t) 512ul)
#define -FLASH BLOCENUM 2int32_t) ({(uint32_t)FLASH END- (uint32_t)FLASH START) -/ FLASH BLOCK SIZE)
#define FLASH BLOCENUM WCRDS (uint32_t) ( (FLASH SIZE WORDS) -/ -FLASH BLOCE SIZE)
#define -IEC TEST_PARAM START ({uint32_t-*)0x20000040)
#define -IEC TEST_PARRAM END ({uint32_t.*)0x200000B0)
#define -RAM START (uint32_t.*)0x20000000
$define ERM DATRRRER END (uint32_t-*) (0x20000B00C -- -0x40)
$define ERM STACK STRRT (uint32_t-*)0x2001E000
#define -RAM END (uint32_t.*
#define TCMEARM START (uint32_t.*
#define -TCMRAM END (uint32_t -*)[0x1000FFCO |
#define -DefaultSystemStartlUp ()
vold-test_fail reset(void):
F#endif-/* - ('defined. (_ BRMCC VERSICN)) -&&- (defined-(_ GNUC_ )} -*/

2. WETRWE.S HEhXIREEMH T A0, WA 2-20. F5) AR, RN

ClassB (/3] TREH

18
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A 2-20. BEIIXHRE

v 5 gd32f470i_iec_test
it Includes
m Application
g bin
Gp CMSIS
[y Dec
g GD32Fdhor EVAL
p GD32F4xx_Peripherals
#p IEC60730 _ClassB
[y ldscripts
v [py Startup
(5L startup_gd32f450_470.5
[y stubs
gen_crc.bat

2-21. %m0 ClassB FE3C#3] eclipse T2

v = gd32f470i_iec_test (in eclipse)
il Includes
p Application
[y bin
Gp CMSIS
= Debug

[y Dec
[y GD32Fdxx EVAL

fp GD32F4xx Peripherals

v gy IECB0730 ClassB
g} gd32fdux_test_clock.c
[§, gd32fdux_test_cpu_prerun_eclipse.$
|5, gd32fdux_test_cpu_run_eclipse.S
€} gd32fdux test flash.c
|5, gd32fdux_test_fullram_run_eclipse.S
(5, gd32fdwx_test_fulltemram_run_eclipse.S
g, gd32fdux test_param.c
46 gd32fdio test_prerun.c
46y gd32fdio test_ram.c
[€} gd32fdux_test_run.c

p ldseripts

[y Startup
[y stubs

gen_crc.bat

HIRSSFER S ACS A RS, WERREG SRS, WHEPNERAT & L0 80 .s
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BN, IR ER-22. BRUESI AR BATIEN, (A fEIB AT L AT BEAT AR .

T oo oo

2-22. BRUBEIXH

%]

o bl /“’ SystemInit */
U

Fl1/* Call SystemInit function */

F2 bl SystemInit

B3 ///* Call static constructors */
F4// bl libc init array

F5/*Call the main function */

Fé bl main

F7 bx 1r

& .size Reset_Handler, .-Reset_ Handler
o0

2 .section .text.Default Handler,™ax", %progbits
3 Default Handler:

4 Infinite Loop:

F5 b Infinite Loop

e .size Default Handler, .-Default Handler

B9 .section .isr vector,"a", %progbits

.glebal _ gVectors

/4 gVectors:

s .wordl_estackl /* Top

of Stack */

3. et fR-23. HEIE A E F S T I BB, n fR2-24. Keclipse LS

B AR B 73, AR O B TUHME e Flash FTRAM R /N IE L 24 it Ao

2-23. SHEUMEBSCAHALE

v = gd32f470i_iec_test
it Includes
p Application
g bin
Ga CMSIS
[y Doc
[y GD32F4x EVAL
p GD32F4xx_Peripherals
#p IEC60730_ClassB

v [ |dscripts

| 9d32f470IK flash.d

[y Startup
[y stubs

gen_crc.bat
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& 2-24. B eclipse TIE4 BUnE S c44

ENTRY (Reset _Handler)

/* end of Stack */
_estack =[8x208368888 ;

[a T ¥y B R WH R %

7/* memory map */

8 MEMORY

91

18 FLASH (rx) : ORIGIN = Bx@3000008, LENGTH = J*30872K*
11 iec_test (wxalri) : ORIGIN = @x200880288, LENGTH = @xB@

12 RAM (xrw) : ORIGIN = @x20880088, LENGTH =[@x2FF5e]/*256K*/
13 flash_end (rxailw) : ORIGIN =|B8xB32FFFCB| LENGTH = @x48

[
[

4. B “Debug Configurations->Debugger” - Device nameJlic &, & 410 AS,
A&P2-25. Device name ZZ B~

& 2-25. Device name Fi0 B

J-Link GDB Server Setup
Start the J-Link GDB server locally [Jconnect to running target

Executable path: ‘C:\Prngram Files (x86)\SEGGERYLink\JLinkGDBServerCL.exe Brow

Actual executable: ‘C:\Prngram Files (x86)\SEGGERYLink\LinkGDBServerCL.exe

(to change it use the global or workspace preferences pages or the project properties page)

Device name: | GD32F470IK | Suppd
Endianness: @) Little O Big

Connection: (@ USE (@] l:l (USB serial or IP name/address)

Interface: ® SWD OITAG

Initial speed: O Auto (O Adaptive (@) Fixed kHz
GDE port: 2331

SWO port: 2332 [ Verify downloads Initialize]
Telnet port: 2333 [ Local host only [ silent
Log file:

Other options: -singlerun -strict -timeout 0 -nogui

5. # I # J8 M “C/IC++ Build->Settings->Tool Settings->Cross ARM GNU
Assembler->Preprocessor” #1“C/C++ Build->Settings->Tool Settings->Cross ARM GNU C
Complier->Preprocessor” 13 I 4 Hif A% 75 22 1) Pl g %, F EAB R & 4108 v R AL T
PR (N B2-26. B0 Sidhi 1E a5y A LT o
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B 2-26. BEOT S 0 B 5

Settings

ER =

Configuration: |Debug [ Active ] ~ | | Manage Configurations...

B Tool Settings & Toolchains B Devices # Build Steps Build Artifact Binary Parsers @ Error Parsers

(& Target Processor [JDo not search system directories (-nostdinc)
(% Optimization [Preprocess only (-E)
§:\. i
(2 Warnings Defined symbals (-D) € & & |
(# Debugging
v B GNU ARM Cross Assembler
(# Preprocessor
(22 Includes
(& Warnings
(Z& Miscellaneous
v B3 GNU ARM Cross C Compiler
@ Preprocessor
(# Includes
(2 Optimization
(# Warnings
(22 Miscellaneous
v B3 GNU ARM Cross C Linker
(2 General
(& Libraries
(2 Miscellaneous
v 3 GNU ARM Cross Print Size
(2 General

GD32F470
VECT_TAB_FLASH

Undefined symbols (-U) &

6. 124 “C++ Build->Settings->Build Steps->Post-build steps->Command” ' () 4, 11 &R2-27.
FPost-build 7S/~ T4y i1 L2 2 PRI elf ST
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& 2-27. &% Post-build 754

= Properties for gd32f470i iec_test O X
s oot
Resource
Builders :
v CjC++ Build Configuration: |Debug [ Active ] ~ | Manage Configurations...
Build Variables
Environment .
Logging 2 Tool Settings %3 Toolchains M Devices [J Container Settings 4 Build Steps Build Artifact Binary Parse * | *
Settings Pre-build steps
Tool Chain Editor
Command:
C/C++ General
Linux Tools Path ‘ v‘
MCU Description:
Project Matures ‘ v‘
Project References
Run/Debug Settings Past-build steps
Task Repository Command:
Task T [ |
ask lags |${:russipreﬂx}ﬂcrussiubjcopy}ﬂcmssisufﬁx} -0 ihex "gd32f470i_iec_test.elf" "Projecthex";.\\gen_crc.bat; vI
Validation
WikiText Description:
Restore Defaults Apply
(‘?:‘ Apply and Close Cancel

7. {2 “Debug Configurations->Startup” i AT AT SCAFIIBC B, 32635 24 1l AR 2 18] vh 4 6 24
i IProject.hex s 4, i £2-28. R AT KT XA B/ -
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& 2-28. BT HATXHEER

Name: | gd32f470i_iec_test Debug

Main [ %% Debugger |8 Startup ™Y Source| =] Common| 2, SVD Path

=11

[~]Enable SWO CPU freq: I:I Hz. SWO freq: I:I Hz. Port mask:

Load Symbols and Executable
Load symbals
(0 Use project binary:

® Use file: || ${waorkspace_loc\gd32f470i_iec_test\Debug\Praoject.hex} || Workspace.. | | File System...

Symbols offset (hex): I:I

Load executable
(0 Use project binary:
@ Use file: |

Executable offset (hex): I:I

Runtime Options

Workspace... | | File System...

[JRAM application (reload after each resetfrestart)

Run/Restart Commands

Pre-run/Restart reset Type: I:I (always executed at Restart)

[Jset program counter at (hex):

Set breakpoint at: | test_prerun |
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3. =FERE T IR SE R

IR R R RS AL B TR, £ 8NP T 9 i R 3 TR IFIZAT, Ik 4 R &/ 3-1.
WG R -

B 31, WRER

FrE¥EEer»»r»» IECEOT30 Test Board Init Success {C{00{000

CPU Test (PreRun) Success!

. Power reset or software reset, next step —> FWDGT reset test ...

PPNy IECAOTI0 Test Board Init Success {400

CPU Test (Prefun) Success!
FWDGT reset
. FWDGT reset test 0K next step —7 WWDGT reset test ...

FRerEyrayyy IECAOTI0 Test Board Init Success  {{€g{{00dd(e

CPU Test (Prefun) Success!

FWDGT reset
WHDGT reset

. WWDGT reset test OE, WDGT test completed ...

Full EAM Test Success!

FLASH CEC32 Test(FreFun) Success!
€

Clock Frequency Test Success!

Frogzram counter test(PreRun) Success'y

Main program starts

FLASH CEC(Run—Time) Test running' Hext Address —3 0x080001fc

FLASH CEC(Run—Time) Test running' Hext Address —3 0x080003£5

FLASH CEC(Bun—Time) Test running! Wext Address —» 0x080005f4

FLASH CBC(Bun—Time) Test runming! WHext Address —3 0x080007£0
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1.0

IR KA

2023408 A 01 H
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Important Notice

This document is the property of GigaDevice Semiconductor Inc. and its subsidiaries (the "Company"). This document, including any
product of the Company described in this document (the “Product”), is owned by the Company under the intellectual property laws and
treaties of the People’s Republic of China and other jurisdictions worldwide. The Company reserves all rights under such laws and
treaties and does not grant any license under its patents, copyrights, trademarks, or other intellectual property rights. The names and

brands of third party referred thereto (if any) are the property of their respective owner and referred to for identification purposes only.

The Company makes no warranty of any kind, express or implied, with regard to this document or any Product, including, but not
limited to, the implied warranties of merchantability and fitness for a particular purpose. The Company does not assume any liability
arising out of the application or use of any Product described in this document. Any information provided in this document is provided
only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality
and safety of any application made of this information and any resulting product. Except for customized products which has been
expressly identified in the applicable agreement, the Products are designed, developed, and/or manufactured for ordinary business,
industrial, personal, and/or household applications only. The Products are not designed, intended, or authorized for use as components
in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, atomic energy control
instruments, combustion control instruments, airplane or spaceship instruments, transportation instruments, traffic signal instruments,
life-support devices or systems, other medical devices or systems (including resuscitation equipment and surgical implants), pollution
control or hazardous substances management, or other uses where the failure of the device or Product could cause personal injury,
death, property or environmental damage ("Unintended Uses"). Customers shall take any and all actions to ensure using and selling
the Products in accordance with the applicable laws and regulations. The Company is not liable, in whole or in part, and customers
shall and hereby do release the Company as well as it’s suppliers and/or distributors from any claim, damage, or other liability arising
from or related to all Unintended Uses of the Products. Customers shall indemnify and hold the Company as well as it's suppliers
and/or distributors harmless from and against all claims, costs, damages, and other liabilities, including claims for personal injury or

death, arising from or related to any Unintended Uses of the Products.

Information in this document is provided solely in connection with the Products. The Company reserves the right to make changes,

corrections, modifications or improvements to this document and Products and services described herein at any time, without notice.

© 2023 GigaDevice — All rights reserved
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